CDOT Workflow IR 24 — Creating A Design Terrain Model

CDOT Workflow IR 24 — Creating A Design Terrain
Model

This workflow demonstrates how to create a terrain model from a corridor model.

Creating A Design Terrain Model Using A Graphical Filter

Set The Corridor Design Stage

The corridor design stage determines how the corridor elements are displayed in
MicroStation. Since the corridor elements are used to create the design terrain Model, it
is important to have them displayed properly. To set the Design Stage:

1.
2.

3.

Open the DGN file containing the corridor using InRoads SS4.

Using the Element Selector, Left Click and hold on the corridor graphic to
display the corridor context menu.

Left Click the Properties button. This displays the Properties dialog box.

In the Properties dialog box, change the Design Stage to 9 — Create Design
Surface. This option displays the corridor top mesh and the linear features.
These elements are used to create the Design Terrain Model.

Feature Name default
Feature Definition Top Mesh

MName 14553 _US62_ Mainline
Horizontal Mame 14553_US62_ Mainline
Use Active Profile True

Profile Mame 145563 _US-62-V
2 - Design v
Description 3 - Final

Start Station - 4 - Final w/ Meshes

End Station - B - Final Top Mesh

- & - Final Bottom Mesh
-7 - Final Linear Feature:
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CDOT Workflow IR 24 — Creating A Design Terrain Model

Set Up The File For The Terrain Model
Because the Design Terrain Model will contain 3 dimensional data, a 3D DGN file is used.

1. Create a new DGN file using the 3D-Seed_CDOT.dgn file.

2. Attach the project geographic coordinate system. For more information on this
process see Workflow MS-24 — Using Geographic Coordinate Systems at
CDOT.

3. Reference the DGN file containing the corridor using the CDOT Default-3D model
and No Nesting.

Reference Attachment Settings for 14353DES_Corridor-01.dgn

File Name: 14553DES_Comidor-01.dgn
Full Path: ...\Drawings‘\Reference Files%14553DES_Comidor-01.dgn
{iiodel? [CDOT Defaut-30 -]
Name Description
14553_US62_ Mainline
s

Logical Name
Description:

pelalica
CDOT Default-30 |

Orientation

View Description

Coincident Aligned with Master File

Coincident - Word Global Origin aligned with Master File
# Standard Views

Saved Views {none)

Mamed Fences {none)

Detail Scale: |1"=100" -
Scale (Master:Ref): | 1.000000 : | 1.000000
MNamed Group: -
Revision -
Level hd
Nested Attachments Mesting Depth: | 1
-

Display Ovemdes: |Alow
MNew Level Digplay: | Lse MS_REF_NEWLEVELD¥
Global LineStyle Scale: | Master -

Synchronize View: | Volume Only i
Toagles = -
k&> ¢ @e @ @]
Drawing Title
Create
Name: | Drawing
==

Displaying The Mesh Boundary

The purpose of a boundary is to prevent triangles from being created outside of the design
area.

1. Setthe active Level to DES_ROADWAY_Mesh-Boundary.
ﬁ CA\Projects\lnRoads 554 Practice Dataset\Designt\Drawings\Reference Files\14333DE5_Finished-Grade_Surface.dgn [3D - V& DGN]

By = 2 2

a1 PR
Fle Edt Eement Settings Tools LUtilities Workspace Applications Window Subsuface Ltiity Help CDOT Help  V06.01.00
T % b 1] Ty |

B -5-828-8-E-a3-2-3-0-Oxiit®

Tasks > 1 X
[ |

):I (none = | DES_ROADWAY_Mesh-Boundary = |

[ m View 1 - Top, CDOT Default
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CDOT Workflow IR 24 — Creating A Design Terrain Model

2. From the MicroStation menu bar, select Tools > Mesh > Mesh Utilities >
Extract Boundary.

H C:\Projects\InRoads 554 Practice Da| v Attributes Files\14553DES_Finished-Grade_Surface.dgn [3D - V& DGN] - MicroStatic
) ) v Primary o ~a T\ - B
(none > | [DES_ROADWAY_Meshi " gi-ndard o j i JI e :3 R ﬁ K
File Edt Eement Settings Main Window Subsuface Lkiity Help CDOT Help V06.01.00
- Product Add-Ins 3 o . .
mil ~ - - - - {1 vl .-
O - ()~ @ v s o -O' R R
Tasks v 03  Animation 0
It
- . »
J E—— = Ea:e Geometry .
i . ells ] e
" Civil Tools Q Q q i 4—1—)' J @ Q Q S, = 7|
| | Change Tracking » % h 4 - \ 6 E
vicdsure r
48 ModelInteroperability ¥ I Mesh *JO 1 Create Meshes 4
k civil cells SRR i PP 2 Modiy Meshes >
= Parametrics M2 13 Mesh Ltilties PI"% 1 Convert Mesh To Suface
30 Geometry b . b m— .
Pai.'temlng =1 Open as ToolBox ‘f 2 Mesh Audt
A Survey -y Point Cloud 4 [ 3 Close Mesh Voids
ﬂ Project Mavigation 4 4% 4 Cleanup Mesh
OpenRoads Help v Propetties 3 [ 5 Exract Boundary
“¢ Drawing R Raster 4 = 6 Unfold Mesh
Redline 2
U8 Wisualization i o N =3 Open as ToolBox

3. Left Click on the design mesh then Left Click in an open area to accept the
selection and create the boundary element.

Editing The Mesh Boundary
If the corridor contains multiple template drops, a boundary element may be created for
individual template drops. This happens when template drops with no transition are
separated to prevent two templates from displaying on one cross section. If this occurs,
the boundary elements must be modified to create a single line, encircling the mesh.
Then the elements are combined into a single closed shape.

Template Drop Boundaries 4

Remove Lines Remove Lines
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CDOT Workflow IR 24 — Creating A Design Terrain Model

Turn off the corridor reference file display so that only the boundary elements are
visible.

[ References (2 of 2 unique, 0 displayed)

- X
Tools  Settings
o . -~ ey
B ye xDEAP P RN T0 %
Slet ¥ % File Name Model Gl 0 &k &
1 14553DES_DesignModel01-End of Lab RDUI 5-3.dgn CDOT Default-30 v
2 14553DES_DesignModel01-End of Lab RDUI 5-3.dan CDOT Default oW
< >
Scale | 1.000000 - | 1.000000 Botation | 00°0000"
Offset X | 0.000 Y | 0.000 Z | 0.000

N & ] > « @e ©]a e

Mested Attachments: | No Mesting
Mew Level Display: | Config Varable v

-

Display Ovemides: |[Allow
Georeferenced: | No

-

2. Using the MicroStation Modify Element tools

Tasks - 0 ¥

[_v. Tasks

-

L

ANE A QPSR = St SRS

Below is the sample boundary, from the illustration above, after editing.
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CDOT Workflow IR 24 — Creating A Design Terrain Model

Next the modified elements are made into a shape.
3. From the Tasks menu, select Create Complex Shape.

Tasks - 0%

[_—1 Tasks - |

4 a7 5 s Bl ac e

"\.I.-".
#¥ Colorado DOT ”:;E_ 1 Drop Element
Q| £F &% — _
LA l 2 Create Complex Chain
W o 1p
E@F T M A ﬁ 3 Create Complex Shape
RY A

T .j;{#:@ [:.’r-'_‘rl 4  Create Region

X Main Classic 5 Add To Graphic Group

L& Detailing
& Drop From Graphic Group

ﬁ Civil Waorlflows

-
ﬁ InRoads Commar I Group Hole

Civil Tools

H © 3 H#

Open 'Groups' as Toolbox

4. Inthe Create Complex Shape tool settings dialog box, set the Method to
Automatic.

5. Left Click on one of the boundary elements, then left click in a blank area to
create the shape.

Left click an element, then

left click a blank area.
Method: \

Max Gap: | 0.001
[ Simplity geometry

Area: | Solid *
Eil Type: |[None =
Fill Color: [J™ 132 =
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CDOT Workflow IR 24 — Creating A Design Terrain Model

6. If the highlighting stops before closing the shape, the place where the
highlighting stops is not connected to the next element. If this occurs, Right
Click to abort the command, then use the Modify Element tools to connect the
elements.

One or both ends of the element are not
connected to the other elements.

h¢J
Method: | Automatic =
Max Gap: | 0.001
[ Simplify geometry
Mrea: | Solid >
Fill Type: |None ¥
Fill Color: |J™ 132 =

7. Once the boundary shape is created, turn on the corridor reference file display.

Creating The Design Terrain Model Using A Graphical Filter
The design terrain model is created from the linear features contained in the corridor
model and the boundary element created in the section above.

1. From the Tasks toolbar, expand the Terrain Model task.
Tasks - 0%

| Tasks ~ |
Civil Tools |

;.% J‘L_]j'r"—_Ll]- rE"'ngun;l’_:lt;\(' J \LL::—'r

Analysis & Reporting

% General Geametry

LR AR

i Horizontal Geometry

BB vertical Geometry w

IJh Terrain Model H

bR ARAR L
*’-""léa %"& ) EAPA
SEa Pt~ @:% -

A %.@* R

=~
Ty
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CDOT Workflow IR 24 — Creating A Design Terrain Model

2. Inthe Terrain Model taskbar, select the Create Terrain Model By Graphical
task. This displays the Create Terrain Model By Graphical task dialog box.

£ Terrain Model HEH S
=0 4 0 0 2 45 T
Ry OO

- R

3. From the Create Terrain Model By Graphical task dialog box, Left Click the
ellipsis button for the Graphical Filter Group. This displays the Graphical
Filters dialog box.

J Create Temrain by Graphic.. | = [ i
Graphical Filter Group  [__| E
| Terrain Filter Manager
gnore Feature Linking
Triangulation Options B
Edge Method Remaove Shvers EI
Feature Y
Feature Definition Proposed Triangles | |
Hame 14553 SHEZ Al

4. In the Graphical Filters dialog box, Left Click on the desired filter. This selects
the filter and dismisses the Graphical Filters dialog box.

E-— Active DGN

EIE Graphical Fiter Groups

If_l---“_'_' Graphical Fiters
= Design Finished Grade
.- Design Grading

Magnlib, CDOT Default

[ e e =
EEI---'E Project_Explorer_Linksets danlib
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CDOT Workflow IR 24 — Creating A Design Terrain Model

5. Left Click the Preview button. This highlights all of the elements that pass
through the filter and are used to create the design terrain model.
[

Graphical Filter Group Design Finished |- -

Terrain Filter Manager

Preview

lanore Feature Linking [

Triangulation Options -~
Feature ~
Feature Definition No Feature Definition| ~
Mame 14553_US 62-Design Te

I
T

NOTE: If required features are not highlighted, an existing filter can be copied
and edited or a new filter can be made. See the last section of this document

Creating A Graphical Filter which includes the steps on how to modify or create
a graphical filter.

6. Inthe Feature area of the Create Terrain Model By Graphical task dialog box,
select the desired feature definition from the drop down menu. In this example
Proposed Border is selected. This sets the display style for the finished grade
terrain model.

@ Create Terrainby ..  — X
Graphical Filter Group  |[E29 Design Finished |-
Terrain Filter Manager

Preview

lgnore Feature Linking  []

Triangulation Options -~
Edge Method [Nane v
Feature ~
Feature Definition No Feature Defin'rtiu:un

- CDOT_Civil_S54xin
@ Temain Contours
- Temain Blement
o[ Temain Flow Amows
A Temain Perimeter

Name
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7. In the Name field, key in the desired name for the terrain Model to be created. In
this example SH-62 Finished Grade was entered.

§) Create Terrain by ... — *

Graphical Filter Group | Design Finished |- |

Terrain Filter Manager

Freview

lgnore Feature Linking  []
Triangulation Options L3
Edge Method None v
Feature Ll
Feature Defimtion Proposed Border w

Mame SH-62 Finished Grade

8. The cursor prompt now reads Triangulation Options: Edge Method. Use the
down arrow to select the None option. This can also be set using the drop down
menu on the dialog box. Left Click to accept the entry.

iy
°

Graphical Filter Group | Design Finished |- |

Terrain Filter Manager

Preview
lgnore Feature Linking [
Triangulation Options ~ \k‘f’
Edge Method Jriore M | IEdge Method
Feature -~ Triangulation Options: Edge Method | [EES v
Feature Definition |Pmpused Border w |
Name |SH-62 Finished Grade |

9. The final prompt reads Data point to accept the selection. Left Click in a blank
area to accept the menu settings and create the surface.

AV

I Diata Point to accept selection |I
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CDOT Workflow IR 24 — Creating A Design Terrain Model

10.Right Click to exit the Create Terrain Model By Graphical command.
Next, the border element created above is added to the design terrain Model.

11.Turn off the corridor reference file display so that only the boundary element is

visible.

) References (2 of 2 unique, 0 displayed) — X
Tools  Settings

E-Rxd ¥DEAPPY NPT X

Slet ¥ 4 File Name Model o] o Kk &

1 14553DES_DesignMaodel01-End of Lab RDUI 5-3.dgn CDOT Defautt-3D VW

2 14553DES_DesignModel01-End of Lab RDUI 5-3.dgn CDOT Defautt VoW W
£ >
Scale | 1.000000 : | 1.000000 Botation | 00°00°00"

Offset X | 0.000 Y | 0.000 Z | 0.000

IlllIl_“—, - g E _.g] mr Mested Atachments: | No Nesting = | Display Ovemides: | Allow
MNew Lewvel Display: |Config Varable ¥ | Georsfersnced: No b

12.In the Terrain Model taskbar, select the Add Features task. This displays the
Create Terrain Model By Graphical task dialog box.

,{h Terrain Model H

= - A
&*Jﬁﬁﬁﬁ'ﬁém
AR R® - DD
Eﬁiuﬁﬁﬁ“

R A g ] A B

13. From the Add Features task dialog box, Set the Terrain Model to the one
created above.

§ Add/Re.. — X
Terrain Model | SH-62 Finished Gradd v |
Feature Type J.SH-62 Finished Grade

14.Set the Feature Type to the Boundary.
@ Add/Re.. — X

Terrain Model |SH-€~2 Finished Grade -~ |

Feature Type

Brezk Line
Contour
Drape Yaoid

Soft Bresk Line
Yoid
Break Void

Colorado Department of Transportation
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CDOT Workflow IR 24 — Creating A Design Terrain Model

15.The prompt reads Locate Element To Add. Left Click on the boundary
element.

Locate Element To Add

Complex Shape ' Line String
Level: DES_ROADWAY_Mesh-Boundary

16.The next prompt reads Locate Next Element To Add — Reset When Done.
Right Click to advance to the next prompt.

X . e
Locate Mext Element To Add - Reset When
Done V"
\ . T

-

=\ PR

-

e

17.The next prompt reads Feature Type. Use the down arrow to select Boundary if
it is not already selected. Left Click to complete the command.

Feature Type

Boundany]

Feature Ty

The illustration below shows the terrain model with triangles displayed so that the
addition of the boundary can be seen. The boundary prevents data from being
created outside of the model area.
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Now that the finished grade surface has been created, the reference file can be
detached.

18.0Open the References dialog box.

19.Right Click on the 14553DES_Corridor-05.dgn and select Detach from the fly-
out menu. This removes the corridor reference file, leaving only the finished
grade terrain Model.

) References (3 of 3 unique, 3 displayed) |L_~_§‘
77005 Settngs
Bov | B3y DG AR Mg D I8 Q@ > Hieiode! (Hite =

Model Orentation %_s

Atach CDOT Defaut Coincident - World Wee
Detach CDOT Defaut-3D Wie

Skt & 3 Fie Name

Exchange
Open in New Session

Activate

Scale | 1.000000 1.000000 | piove
Rotation  00°00°00" Offset X | 0000 | Copy
IR ] > < @[] S

Nested Attachments: [No Nesting Botate
. Merge into Master

New Level Display: (Config Veriable ~

v aKe Uirect Xtachment — -4

20.Dismiss the References dialog box.
21.Using the Terrain Properties dialog box, set the display as desired. In this
example, triangles are displayed.
The illustration below shows the design terrain model with triangles displayed. Notice
that the triangles are inside the border element.

AN
N

N
g

awy

QN
ety
SR
0
OX
X
Sl

U)o
A o,
o
.//ﬁ?:{aliﬁ#’e‘%’»‘% .
Wi
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Creating A Terrain Model Using Create From Elements Command

A design surface can be created using the corridor mesh and the mesh boundary. The
steps for displaying the mesh boundary are the same as those outlined above. This
section describes the process of creating the terrain Model from the mesh and mesh
boundary.

Note: Before following the steps below, the corridor’'s Design Stage must be setto 5 —
Final Top Mesh and the Mesh Boundary must be displayed.

The steps below use the mesh boundary and the corridor mesh to create the terrain
model. In this example, the mesh boundary is used first to create the design terrain
model. The top mesh is then added to this terrain model.

Create A DGN File To Contain The Terrain Element

1. Create a new DGN file using the 3D-Seed CDOT.dgn file.

2. Attach the project geographic coordinate system. For more information on this
process see Workflow MS-24 — Using Geographic Coordinate Systems at
CDOT.

3. Reference the DGN file containing the corridor using the CDOT Default-3D model
and No Nesting.

Reference Attachment Settings for 14353DES_Corridor-01.dgn

File Name: 14553DES_Comidor-01.dgn
Full Path “Drawings'\Reference Files"14553DES_Comidor-01.dgn
$i54s) [CDOT Defout30 <]
Name Description
14553_US62_ Mainline
s

Logical Name
Description:

'
CDOT Default-30 |

Orientation

View Description

Coincident Aligned with Master File

Coincident - Word Global Origin aligned with Master File
# Standard Views

Saved Views {none)

Named Fences {none)

Detail Scale: |1"=100" -

Scale (Master:Ref): | 1.000000 : | 1.000000
Named Group: -
Revision e
Level -
MNested Attachmerts Mesting Depth: | 1

Display Ovemdes: |Alow hd
New Level Display: | Use MS_REF_NEWLEVELD¥
Global LineStyle Scale: | Master -
Synchronize View: | Wolume Only T

N @ R » « @ [@ @[]

Drawing Title
Create

Toggles

Name: | Drawing

Corce
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Displaying The Mesh Boundary
Refer to the sections Displaying The Mesh Boundary (page 2) and Editing The Mesh
Boundary (page 3) for instructions on displaying and editing the mesh boundary.

Creating The Design Terrain Element

1.
2.

ok

From the Tasks toolbar, expand the Terrain Model task.
In the Terrain Model taskbar, select the Create From Elements button. This
displays the Create Terrain From Elements dialog box.

| 2 rerrain Moder u==a.|
1 2 /.;?;a\@ % |
BRBM ML
ERIBBAH

R R E S L

In the Create Terrain From Elements dialog box, set the Feature Type to the
desired option. In this example Boundary is used.

Set the Edge Method to None.

In the Feature area, set the Feature Definition to the desired option. Here,
Proposed Border is used.

In the Name field, key in the desired name. In this example, SH-62 From Mesh
is entered.

w

Feature Type Boundary v
Edge Method None v

Feature ~
Feature Definition | Proposed Border W
Name SH-62 From Mesh

Colorado Department of Transportation
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7. Left Click on the element to be included in the terrain model. In this example,
the boundary element is selected.
8. Right Click to move to the next prompt.

@ Create Terrain... — *

Feature Type
ocate Next Element To Add - Reset When I Edge Method

Done

Feature -

Feature Definition | Proposed Border ~
Name 5H-62 From Mesh

ine String
I: DES_ROADWAY_Mesh-Boundary

o J“’
(LN -‘_‘.._,_.,._:!ﬂ'é%!!“ii
] Il'lll'}ll'%':gﬁ:‘ ‘= \'{
““\i i

T

i
I|I".III JI'I Il }III\'.IIH_I‘

P LTES
LAY llll-fll\h'l‘ IIIIII\I'!HI Hm I]III‘ ]
Wi g

!llll.'lq

L I
I f LA [ i

S

[
il

NH
i

9. Left Click through the remaining prompts to complete the command.

This creates the design terrain model and launches the Add Features command.
This command is used to import the design top mesh. If the Add Features is not
launched, it can be started from the task menu. If the Add Features command is

launched from the Task Menu, select the Terrain Model created above in the dialog
box.

v

Terrain Model |SH-62 Design v |
Feature Type ‘Boundar}' e ‘

10.The prompt reads Locate Element To Add. Left Click on the desired element.
In this example, the design top mesh is selected.

11.The second prompt reads Locate Next Element To Add -Reset When Done.
For this example, no other items are used, so Right Click to move to the next
prompt.

Colorado Department of Transportation
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T LT oo Locate Mext Element To Add - Reset When I

R g R . J Done

6 e

12.The third prompt reads Feature Type. Use the down arrow to select the desired
feature type. For the design top mesh, Soft Breakline is used. Left Click to
complete the step.

] Feature Type

Feature Typel} Soft Break Line

13.1f this is the last item to be added, Right Click to exit the Add Features
command. In this example, only the boundary and design top mesh are used.
This completes the design terrain model.

KIS
'%‘,’ﬁgi'f}féj""
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Creating A Terrain Model From Alternate Surface

A design surface can be created using the Alternate Surface points defined in the
template. Using this option to create the design terrain model in the corridor DGN file
allows a DTM or LandXML file to be exported that contains the Feature Definitions for
the design data.

Creating a design model from Alternate Surface will require a boundary created from
the design mesh as defined above. The following steps assumes that the boundary has
already been displayed. The mesh boundary must be displayed in the 3D Model
containing the corridor. The remaining steps are done in the 2D Model.

Updating The Template To Make An Alternate Surface

To create a design terrain model from Alternate Surface, the points used for the
alternate surface must be specified in the template. The illustration below shows the
Top-of-Cut point with the Alternate Surface label (SH-62 Finished Surface) applied.

Name: Top-of-Cut - jﬂ __EHT_T
Use Feature Name Overide:  Tag-of Cu Close |
Feature Definition: D_Teg-of-Cut F—l
_ < Prawiows
Superslevation Flag J
Mead =
Atemate Suface 5H-62 Finished Grade
End Condiion Propertse Help |
| Check for Interception Member of
Cut_2A1

| Place Poirt at Imterception
+| End Condition is Infinte

Do Mot Construct

All template points to be used for a single Alternate Surface must have the same
Alternate Surface label. A separate Alternate Surface will be created for each unique
label found in each template of the corridor.

Note: If the Alternate Surface labels are applied after the corridor has been defined, the
corridor has to be reprocessed before the alternate surface can be created.

Colorado Department of Transportation
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Creating The Alternate Surface
Creating the complete alternate surface requires two commands; Create Corridor
Alternate Surfaces and Add Features. The first command creates the design terrain
model from the template features and the second adds the boundary element to that
surface.

1. From the Tasks toolbar, expand the Terrain Model task.

2. Select the Create Corridor Alternate Surfaces button.

Tasks - 1%

|Tasks -
| Civil Tools |

""" ._|'_Eﬂ;||_‘1?._} L7 X i ok,

< Analysis & Reporting -

b General Geametry

L]

. Horizontal Geomatry w

BE vertical Geometry w

4% Terrain Model H E L
YL LYY LY
Ay B »% N8 - TARN
=y Y B

A B ] e

H Carridor Modeling w

3. There is no dialog box associated with this command. The first prompt reads
Locate Corridor. Move the cursor on to the corridor and Left Click. This creates
the alternate surface terrain model.

Next, the boundary is added to the design terrain model.

4. Inthe Terrain Model taskbar, select the Add Features task. This displays the
task dialog box.

Colorado Department of Transportation
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d Terrain Model -H )

Oy mig A S LR
SEaE = N
R A & F) & 52 g

5. From the Add Features task dialog box, Set the Terrain Model to the one
created above.

§ Add/Re.. — X
Terrain Model | SH-62 Finished Gradd v |
Feature Type J.SH-62 Finished Grade

6. Setthe Feature Type to the Boundary.
@ Add/Re.. — X

Terrain Model |SH-€~2 Finished Grade -~ |

Feature Type

Brezk Line
Contour
Drape Void

Soft Bresk Line
Yoid
Break Void

7. The prompt reads Locate Element To Add. Left Click on the boundary
element.

Locate Element To Add

Complex Shape ' Line String
Level: DES_ROADWAY_Mesh-Boundary

Colorado Department of Transportation
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8. The next prompt reads Locate Next Element To Add — Reset When Done.
Right Click to advance to the next prompt.

X %
Locate Mext Element To Add - Reset \when "
Daone L

-_— S— _—'—'_'_'_'_'_K—'_'_

9. The next prompt reads Feature Type. Use the down arrow to select Boundary if
it is not already selected. Left Click to complete the command.

This completes the design terrain model. The illustration below shows the model set
to display triangles.

il
<

N
XY
AP
SRS
S
WX
QO
)
il

A % . 7 /,’ /%
1) )5 attony
il
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When a terrain model is created as described in this section, the Feature Names
and Feature Definitions are attached to the linear features. The illustration below
shows the RT_HMA_Liftl_Laneline-Top feature highlighted. Notice that it belongs to
the terrain element and that it is on the correct level for that feature.

14553_US62_ Mainline: RT_HMA_Lift1_Laneline-Top /

By Profile Name : ProfileBy Template
Lol SR LTCRTIT) P

In Terrain Model: 14533_UUS62_ Mainline.Finished Grade
Level: DES_ROADWAY _Laneline-Top

When exporting the terrain model to a DTM or LandXML file, the Feature Names
and Feature Definitions are included in the exported data.

[t Feature Properties
Surface: 14553_1S62_ Mainline Fir ~

» Feature:
= hEla B - o
ame %
A X Element1 Default
\ & InRoads OTM HMA_Lift1_Centerine-Top D_Centerine-Top
- LT_HMA_Lift1_EQOP-Top D_ECP-Top
LT_HMA_Lift1_Laneline-Top D_HMA_Pvmt
- LT_POSS D_POSS
% LandxML LT_Toe-of-Fill D_Toe-of-Fill
" LT_Toe-of-Fill1 D_Toe-of-Fill

Kl LT_Toe-of-Fill10 D_Toe-of-Fill

LT_Toe-of-Fill2 D_Toe-of-Fill
LT_Toe-of-Fill3 D_Toe-of-Fill
LT_Toe-of-Fill4 D_Toe-of-Fill
LT_Toe-of-Fil5 D_Toe-of-Fill
LT_Toe-of-Fil6 D_Toe-of-Fill
LT_Toe-of-Fill7 D_Toe-of-Fill
LT_Toe-of-Fillg D_Toe-of-Fill
LT_Toe-of-Fills D_Toe-of-Fill
LT_Top-of-Cut D_Top-of-Cut W

The illustration above shows the Feature Properties of the exported terrain from
alternate surface. Notice that the feature names and feature styles are included.
Elementl is the boundary. The Add Feature command used to create it does not
allow for the feature to be named or given a feature definition so default values were
used.

Colorado Department of Transportation
Page 21



CDOT Workflow IR 24 — Creating A Design Terrain Model

Working With Graphical Filters

Graphical Filters allow the user to create a terrain element based on a predetermined
set of criteria. Some graphical filters are included in the workspace. These cannot be
edited. However, they can be copied from the dgnlib to the active dgn file for editing.

Editing An Existing Graphical Filter
Graphical Filters can be copied from the dgnlib to the active dgn file for editing.
1. From the Tasks toolbar, expand the Terrain Model task.

Tacks - I X

| Tasks ~ |
Civil Toals |

ERBEATE | URTIR N &

analysis & Reporting v
% General Gea metry

<. Horizontal Geometry

BH vertical Geomebry -

Fﬁ;l?ﬁ%@ .

2. Inthe Terrain Model taskbar, select the Graphical Filter Manager Task. This
displays the Terrain Filter Manager dialog box.

d Tarrain Model = A

o D G B A 5
ARRH WAL
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3. Inthe Terrain Filter Manager dialog box, Right Click on the filter and select

Copy from the menu.

F! Terrain Filter Manager

AN

)T_Graphical _Temrain_Fiters dgnlib, COOT Default

P

esign arading CDFI)"

Preview

Design Finished Grade )
sign Grading Clear Preview

- O *
Properties
General ~ N
Name Design Finished Grade
Description
Break Lines
Linear
Btures
EGTT e Edit Filter
Filter By ~
Colors
Levels v
Finish

4. Right Click on Filters under the active DGN file and select Paste
an editable copy of the graphical filter.

F! Terrain Filter Manager

.x\\

Create Filter

Create Filter from Selection Set

Paste

Clear Preview

Design Finished Grade
Design Grading

Colorado Department of Transportation
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Design Terrain Model

5. Right Click on the copied Filter under the active DGN file and select Rename.
Key in the desired name.

F! Terrain Filter Manager

" HIELER ST

Comidor Test.dgn
e Filter Groups

Properties

General

MName

reate Design Surfaces
® Design Finished Grade
esign Grading

esign Finished Grade

P

Copy of Design Finished Grade

5 Design Grading

Create Filter | |
Create Filter from Selection Set
|Break Lines w |
Copy
Paste Linear
Delete = g
Rename Edit Filter
Preview ~
Clear Preview O
Levels O W
Finish

6. Left Click the Edit Filter button on the right side of the dialog box.

This displays

the Edit Filter dialog box.
- T —
ﬁ Terrain Filter Manager = |6 &
L S - il
| W L 8 AKX
[ufl 14553DE5 _Finished-Grade_Suface.don Fropeies
== Filer Groups
L. General -
47 SHE2 Finished Grade Narme SHE2 Finished Grads
0T _Graphical_Teran_Fiters dgnlib, COOT Defauit .
= G Descripbon
’ Feature Type Bresk: Lines =l
Grade
Filter Typa Linzar
Link to Terrain Features |
Filker By -
| Finesh ] I
L= i — J
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7. In the Edit Filter dialog box, left click on the Civil Features option on the left
side of the dialog box. From here, Feature Definitions used to define the
finished grade are selected.

- e —
I Edit Filker = 2
Ciwil Feahwes F,
Select Civil Features -l
Colors Features ‘n Add -> Sedacted Features
Levels ALG_COGO_Poirts
ALG_COGO_Paints3
Element Types 0l EX 100 Al ==
_ ALG_EX_100_Rt
Line Styles ALG. EX_500
Line \sizights ALG_EX_500_Lt
ALG_EX_500_Ri
Cell Names 0LG_EXISTING
-L':_E."|: MG-Ak
Transparency ALG_OTHER
ALG_OTHER_100 —
Template
Fl i 3
Elevations WildCard:
Add->
| BySel. | [=2 Prev.| (& Prev.| [ Cancel | [ Finish |

ke

8. In the Features menu (on the left), highlight the desired items (hold down the
Crtl key to select multiple items. The feature definitions selected need to match
the feature definitions used on the template points required to create the design
terrain model.

@i -
Civil Featwes —
Select Civil Features "]
Colors Eaatures s l Add -> I Selactad Features
Levels pross [
D_ROADWAY-Asphal
Element Types O_ROADWAY-Dit All -
Line Styles o o e
Line \isights 0_SHOULDER
O_SHOULDER-Embarik
Cell Names O_SHOULDER-Top
Civil Features 0_SUBBASE
Lh_=hicne
Transparency D_Toe-af-Fil
D_Top-of-Cut -
Template - = b
Elevations \fildCard:

| BySel. | |= Prev.| (& Prev.| [ Cancel | [ Finish | I
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Selected Features list.

CDOT Workflow IR 24 — Creating A Design Terrain Model

9. Left Click the Add button to add the selected Feature Definitions to the

PB4 Edit Fitter - h 4
Civil Features (19) 'F,
Select Civil Features -I
Colors Features 2 Add -> Selected Features 2
Levels D_CONC_Sw_Gin T D_Centerline-Top

O _CONC_Sw_C D_COMC_Sw_d4in-Top
Element Types R — Al D_CONC_Sw_Sin-Top
Line Strles D_CURB_Back D_CONC_Sw-Top
y D_CURB_FL_FRt D_CURE_Back-Top
Line Weights D_CURB_Top D_CURE_Fowline-Tof
D_CURB_Ty-2_Sect-B O_CURB_Front-Top
Cell Names D_CURB_Ty-4_SECT-M D_CURB_Gutter_Froni
Civil Feat (19) D_CUBB -5_.SECT-M D_DITCH-Backslope
D_DRIV Asphalt [O_DITCH-Bottom
Transparency D_DRIVEWAY-Concrete [O_DITCH-Foreslope
| - v D_EOP-Top w
Template z 2 2 =
Elevations WildCard:
| | [ add>
By Sel.. =5 Prev. ﬁ Prev.. Cancel Finish

10.To remove items from the Selected Features list, Highlight the desired items in
the Selected Features list.
11.Left Click the Remove button to delete the selected items from the Selected

Features list.

PB4 Edit Fitter - h 4
Civil Features (27) 'F,
Select Civil Features -I
Colors Features 2 Add -> Selected Features 63
Levels D_DRIVEWAY-Asphalt D_CONC_Sw-Top

D_DRIVEWAY-Concrete D_CURB
Element Types O_DRIVEWAY-Dirt All > D _CURB_Back
. D_DRIVEWAY-Gravel D_CURE_Back-Top
Line Styl - < Nene -
ne =hies D_EOP D_CURB_Flowiine-Tor
Line Wweights D_EOP-Grading D_CURE_Front-Top
D_FEN (Plastic) 0_CURB_Gutter_Frord
Cell Names D_FEN (Temp) D_CURB_Top
Civil Feat o) D_FEN_Barbed-Wire D_DITCH-Backslope
D_FEN_Bamier [O_DITCH-Bottom
Transparency D_FEN_Barmier-MP [O_DITCH-Foreslope
D_FEN_BW_MP v D_EOP-Top w
Template z 2 2 =
Elevations WildCard:
| | [ add>
By Sel.. =5 Prev. ﬁ Prev.. Cancel Finish
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12.Left Click the Finish button to complete the filter definition. This dismisses the
Edit Filter dialog box.

o N oo

Ciwil Fealuwres (B)
Select Civil Features

Features Selactad Featuras

ALG_COGO_Poirts D_Centedine-Top
ALG_COGO_Foirisd D_ECP-Tap
Element Types ALG_EX_100 = D_LAMELINE-Top
ALG_EX_100_Rt T D_PO55
ALG_EX_500 D_Toe-of-Fil

Line \isights ALG_EX_500_Lt D_Top-ot-Lut

Lina Styles

ALG_EX_500_R
Cell Names ALG_EXISTING
ALG_EXISTING_ Vet
ALG_EXISTING-4i
Trarsparency ALG_OTHER
ALG_OTHER_100

Civil Features (B)

Templata

Elevations

13.In the Terrain Filter Manager dialog box, Left Click the Finish button. This
completes the graphical filter.

=g D OO0 nAN

=W 14553DES_Finshed Grade_Surface. dgn Properties
== Fiter Groups G al
':;-,u!_f Fiters ot

247 SH62 Finshed Grade Name SHE2 Finshed Grads
2 - COOT_Graphical _Teran_Fiters dgnlb, COOT Defaut )
S22 Fiter Groups Description
=)-=2 Creste Design Sufaces Feature Type Break Lines
i-- 22 Deaign Finshed Grade
L2 fosion Gradng Filter Type Linear

== I.'}_U'J Link to Terrain Features F
i-sme Desgn Finished Grade

!-ﬂf Desgn Gradng Edit Filter

Filter By
Colors
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Creating A New Graphical Filter
1. From the Tasks toolbar, expand the Terrain Model task.

Tasks - 0 X

|Tusl-c5 - |
Civil Toals |

]}_d_‘?'_l' 'ﬂ'x_l' L |—I

* Analysis & Reporting -
% General Gea metry -
<. Horizontal Geometry w

BB vertical Geometry -

@@%% %m@
£/ 3 g@&w
YT

2. Inthe Terrain Model taskbar, select the Graphical Filter Manager Task. This
displays the Terrain Filter Manager dialog box.

d Tarrain Model = -
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3. Inthe Terrain Filter Manager dialog box, in the folder tree on the left, Right
Click on the Filters Folder.

4. Select Create Filter from the flyout menu. This places a New Filter under the
Filters folder.

S =)

wuD ISRV

-l 145530ES_Firished-Grade_Suface.dan Propeadies
] == Edo. oy o

T Clear Preview
L T

22 Diesign Finished Grade
B8 Design Grading

5. Right Click on the New Filter and select Rename from the flyout menu.

s Terrain Filter Manager
B nag

T T —

k- AsUELEE , 0

- 145530ES_Firished-Grade_Surface don Prapesties

i == Fiter Groups
General

T = e
i (S ——— Create Filter

=== Fiter Groups Create Filter from Selection Set

== Creale Des sture Type

-2 Deson

L2 Deagn

=55 Fiters I Rename k to Terrain Features ]

52 Design Fini

E"-'T" Diesign Gra Preview Filter

Clear Preview Filter By

i
ECripbon

Er Type

Colors Fl
-
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6. Key in the desired name and tap the Enter key.
7. Left Click the Edit Filter button on the right side of the dialog box. This displays
the Edit Filter dialog box.

[ =T
¥4 Terrain Filter Manager = | = &%
L P | A

5 us Tyl 8 AKX
[ 14553DE5 _Finished-Grade_Suface dgn Propeties
=2 Filer Groups
5B Eyer General -~
47 SHE2 Finished Grade Name SHA2 Finished Grade
a1 COOT_Graphical_Temain_Fhers. dgnib, COOT Defaut .
=== Fiter Groups Description
2= Create Design Sufaces Feature Type Bresk Lines =]
2% Design Fnshed Grade )
B en Gradig Filter Type Linear
= Lirk to Terrain Features |
L-n r Firished Grade .
Filter By -
[ Finash ] I

ke ——

8. In the Edit Filter dialog box, Left Click on the Civil Features option on the left
side of the dialog box. From here, Feature Definitions used to define the
finished grade are selected.

- ) ) —
I edit Fitter = P
Civil Feahmes Frp
Salect Civil Features -I
Colors Features = Aod - Sedactad Featumag
Levels ALG_COGE0_Points l
ALG COGO_Points3
Element Types ALG_EX_100 Al
ALG_EX_100_R
Lima Styl S
ne shies ALG_EX 500
Line \isights ALG_EX_500_Lt
ALG_EX_500_R
Cell Names \LG_EXISTING
Civil Featwes | 7
ALG_EXISTING-Ak
Transparency AL OTHER
ALG_OTHER_100 -
Templata -
4 ] 3
Elevations \wfildCard:
Add->
. By Sel.. | |E Frev.. k F'rw..| | Cancel | Finish |
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9.

In the Features menu (on the left), highlight the desired items (hold down the

Crtl key to select multiple items. The feature definitions selected need to match
the feature definitions used on the template points required to create the design
terrain model.

Ber N -
Civil Fealmes Frp
Select Civil Features -:
Colors Features A I A - J Sedacted Features
Levels p.Foss g
D_| ¥-Asphal

Element Types D -Dirt Al -»
O _ROADWA Y G

Line Syten '-? DWAYGrave]
oS

Line \wieights O_SHOULDER

0_SHOULDER-Embark

Cell Names 0_SHOULDER-Tog
Civil :_En-‘-l’.:-‘l’

Lk_swae
Transparency D _Toe-of-Fil
D_Tep-ofCu ,
Templats | = .
Elevations #fildCard
Add-»
| BrSel. | [=2 Prev.| (& Prev.] [ Concel | Finish |

10.Left Click the Add button to add the selected Feature Definitions to the
Selected Features list.

L. e
Ciwil Features () Fp
Select Civil Features -:
Colors Features = Sedacted Faaturas
Lewvels 0_Sawcut | | | «-Famove D_Centerdne-Top

O_SHOULDER D_EOP-Tap
Element Types D_SHOULDER-Embark: D_LANELINE-Top
0 _SHOULDER-Top D_POSS
- : - Hone -
Line Styles D_SUBBASE D_Toe-of-Al
Line \wieights U_owale D_Top-of{ut
0_Wall-Retaining
Cell Names D_Wall-Top
- D_Wall-Wing
Civil Feahmes - -
®© Defauk
Trarsparency OTM_Extenior
DTM_Extesior? ,
Templats | = .
Elevations \wiildCard:
Add-»
| BwSel. | =2 Prev.| (& Prev.| | Concel Finish |
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11.Left Click the Finish button to complete the filter definition. This dismisses the

Edit Filter dialog box.

Civil Features (6)
Select Civil Features

Features
ALG_COGO_Pairts
ALG_COGO_Pairts3
ALG_EX_100
ALG_EX_100_R
ALG_EX_500
ALG_EX_500_Lt
ALG_E¥_500_R
ALG_EXISTING
ALG_EXISTING Vet
ALG_EXISTING-4t
ALG_OTHER
ALG_OTHER_100

1 m | *

Element Types
Line Styles

Line Weights

Cell Names

Civil Feahwes (5)
Transparency

Template

Sedacted Featuras
D _Centedne-Top
D_ECP-Tap

D _LANELINE-Top
D_POSS
D_Toe-of-Al
D_Top-of{it

Elevations \wiildCard:

BwSel. | [=2 Prev.| (& Prev.| | Cancel |

12.In the Terrain Filter Manager dialog box, Left Click the Finish button. This
completes the graphical filter.

R . 2o N
=g 05 8 534X
= 14553DES_Finshed-Grade_Suface dgn
== Fiter Groups
:;,,H.l} Fiters
L. 2 SHE2 Finshed Grade
33 COOT_Graphical_Temran_Fiters dgnlb, COOT Defaut
=== Fiter Groups
== C Design Sufaces
i-- 242 Deaign Finshed Grade
L. 2% Degign Gradng
=35 Fiters

= :.“‘"',’ Desgn Finished Grade

.22 Design Gradng

Propedties
General
Name
Description
Feature Type
Filter Type
Link to Terrain Features
Edit Filter

Filter By

Colors
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